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Chapter 17: Horizontal and Vertical Design 

Introduction 

Since there are many different, and acceptable, methods of 
creating horizontal and vertical geometry using GEOPAK, this 
chapter will not dictate the exact methods to use.  Instead we 
will describe the different methods that can be used.  This 
chapter will be in two sections: Horizontal Design and Vertical 
Design. 

Horizontal Design 

There are four methods of setting a horizontal alignment: 
Coordinate Geometry (COGO), Graphical COGO, Horizontal 
Alignment Generator, and Store Graphics.  Any of these 
methods are acceptable to EFLHD.  Each one of these 
methods have their advantages and disadvantages, since 
graphical COGO and the horizontal alignment generator are 
similar, we will address these tools together.  This chapter 
will describe each of the above listed methods and indicate 
their advantages and disadvantages.  Regardless of the 
method used, the final alignment must be drawn into 
MicroStation using the GEOPAK D&C Manager, with the 
EFLHD .ddb file.  This will assure that the elements are 
drawn with the correct symbology, matching the EFLHD 
standards. 

Coordinate Geometry 
Coordinate Geometry can be accessed using Project Manager 
by selecting the Coordinate Geometry button. 

 

Figure 17-1:  Accessing COGO through Project Manager 17-1
3/27/2007  
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You can also select the Coordinate Geometry button on the 
GEOPAK main dialog box. 

 

Figure 17-2:  Accessing COGO through Road Tools Icon 

If you are using Project Manager, Coordinate Geometry dialog 
box will be invoked.  Otherwise, the Job Number and 
Operator code will have to be entered in the COGO Startup 
dialog box.  Project Name and Subject are optional fields.  
Press the OK button to bring up the Coordinate Geometry 
window. 

 

Figure 17-3: Coordinate Geometry 

You can create the horizontal geometry by typing commands 
in at the COGO command line, by creating an input file with a 
sequence of COGO commands and loading it into COGO, or 
by using the dialog box driven Store Curve from Tangents, 
Locate Traverse, etc., tools that are accessed from the COGO 
pull down menus to generate the commands.  If you use the 
input file method, remember that the COGO input file name 
can only be 8 characters long, must have the job number as 
the last three digits in the name, and the extension has to 
have an “i”+ the operator code.  (i.e. XXXXX101.ijd), where 
the i stands for input file. 
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Advantages. 

• This method allows the user to have more precise 
control over tangent bearings, control point 
coordinates, etc., than with Store Graphics, if done 
properly. 

• The user can set visualization on to view progress of 
design. 

 

Disadvantages. 

• Commands for the command line and input file 
methods are difficult to memorize. 

• Small adjustments are hard to make. 

• Process is time consuming. 

Uses. 

• Reviewing both horizontal and vertical alignments. 

• Creating output of alignments for printing. 

• Tweaking alignments that were created using store 
graphics, or any of the other methods. 

• Storing as-built centerline chain and profiles, especially 
those for which there are only hard copy paper plans. 

Graphical COGO / Horizontal Alignment Generator 
Overview 
Graphical COGO and the Horizontal Alignment Generator, 
allow the user to create coordinate geometry elements, much 
the same as the original COGO tools, but with a much more 
graphic and user-friendly process.  Graphical COGO and the 
Horizontal Alignment Generator can be accessed by selecting: 

Applications>GEOPAK 
ROAD>Geometry>Graphical Coordinate 
Geometry, or  

Applications>GEOPAK ROAD>Geometry>Layout 
Horizontal Alignments 
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Figure 17-4:  Accessing Horizontal Alignment 
Generator and Graphical COGO  

Or by selecting the icons from the main GEOPAK Road tool 
box. 

             

Figure 17-5:  Graphical COGO Icons 

The Horizontal Alignment Generator can also be accessed 
using Project Manager by clicking on the Horizontal Alignment 
button on the flow chart and selecting Graphical Element 
Based geometry.  Graphical COGO cannot be accessed 
directly from Project Manager. 

Graphical COGO 
The Graphical COGO tool frame, shown below contains tools 
for creating COGO elements such as lines, points, curves, 
modifying COGO elements, manipulating elements, and 
grouping elements. 

 

17-4
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Figure 17-6:  Graphical COGO Tool Frame 

From the main Graphical COGO tool frame, shown above, 
additional tools may be accessed from each of the four main 
tool boxes. 

 

 

 

 

Figure 17-7: Graphical COGO Tools 

 

 

 The Graphical COGO tools shown above, and those 
in the Horizontal Alignment Generator, look and act 
the same as many MicroStation tools.  However, 
these tools are not relying on the accuracy of 
MicroStation graphics, but rather the much more 
accurate GEOPAK coordinate geometry engine.

 

 

 

Horizontal Alignment Generator (Element Based) 
 
Horizontal Alignment Generator can be accessed by selecting 
third icon in the Horizontal & Vertical Geometry toolbox.  
Selecting this icon will invoke the Horizontal Alignment 
Generator Menu. 

17-5
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Figure 17-8:  Horizontal Alignment Generator  

 

Figure 17-9:  Horizontal Alignment Generator Menu 

The File pull-down menu allows the user to set preferences 
for how newly created elements will be displayed, how to 
name elements, and which geometry tables to use as a 
default.   EFLHD uses the Spiral Design Tables.  To access the 
Spiral Design Tables, path should be set to 
M:\Cadd_resource_v8\X_30\Standards\Bin\english or metric. 

 

Figure 17-10:  Horizontal Alignment Generator 
Preference 

The Design Tables menu allows the user to view the settings 
for the current default design tables.  In the Design Tables 
pulldown, the user sets the paths and file names for the 
tables to be accessed.  Currently EFLHD uses only the Spiral 
Curve tables (Metric and English).  Once the English or Metric 
Spiral Curve table is selected, select the design speed and 
number of lanes.  These tables correspond with the AASHTO 
Green Book.   

17-6
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Figure 17-11:  Design Tables – Spiral Curve 

The tools menu activates the COGO tools that will be used to 
create geometry elements.  Selecting Tools>Main accesses 
the following tool frame. 

 

Figure 17-12:  Horizontal Alignment Generator Tool 
Frame 

From the main tool frame, shown above, additional tools may 
be accessed from each of the six main toolbox icons. 

17-7
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Figure 17-13:  Horizontal Alignment Generator Tools 

Each of the tool boxes shown above, as well as the tools from 
Graphical COGO, may be used together to create any 
combination of geometry, from the simplest to the most 
complex. 

Advantages 

• Using these tools to set a horizontal alignment, if done 
properly, is just as accurate as traditional command 
line COGO. 

• The user does not have to remember syntax of COGO 
commands.  

Disadvantages 

• The Graphical COGO and Horizontal Alignment 
Generator tools can be complicated. 

• The process is slower than using store graphics, as 
detailed below. 

Uses 

• When the geometry is known, as the input of As-Built 
alignments. 

17-8
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• When the user wants to give exact bearings and 
distances. 

Store Graphics 
The store Graphics procedure is the simplest and quickest 
method to create a horizontal alignment.  The user can use 
standard Microstation draw utilities to layout the alignment 
then use the Store Graphics tool to store the alignment into 
COGO.  Even though Microstation measurements are to single 
precision, GEOPAK stored elements are computed to double 
precision accuracy.  Store Graphics will make slight 
adjustments to the graphical element locations as required 
forcing each element in the chain to be exactly tangent to the 
immediately preceding element and the immediately following 
element.  These adjustments are always minor (e.g. the 
coordinates of a curve’s PC and/or PT may be adjusted a few 
millimeters to force the curve to match the tangents exactly) 
but they do occur and the user has no control over them.  
However, if the graphical elements were drawn correctly then 
the chain that gets stored into the gpk file is exactly as 
“accurate” as a chain stored using any of the other methods. 

This command cannot be accessed using Project Manager, but 
can be accessed the following two ways.  From the GEOPAK 
pull down menus select, Applications>GEOPAK 
ROAD>Geometry>Store Graphics 

 

Figure 17-14:  Accessing Store Graphics 

17-9
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Or by selecting the icons from the Geopak Road tool box as 
shown below: 

 

 

Figure 17-15:  Store Graphics Icon 

Selecting the Store Graphics Icon will invoke the Store 
Graphics Dialog box.  You can store the elements as Complex 
Chain, Selection Set or Single Element. 

 

Figure 17-16:  Store Graphics 

Advantages 

• Use simple Microstation commands to layout 
alignment, adjustments to alignment are quick, and 
the only point numbers used are on the alignment 
(usually just the first and last). 

Disadvantages 

• Not as accurate as COGO.  Store Graphics makes minor 
adjustments to the as-drawn elements in order to get 
them to tie together mathematically. 

• Cannot draw spirals using Microstation commands.  If 
spirals are needed, you must use Horizontal Alignment 
Generator to create that element, and then you may 
continue using Microstation commands.  

17-10
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Uses 

• For long alignments with many elements.   

 

Horizontal Design – Geopak 2004 
In GEOPAK 2004 there have not been many enhancements to 
the workings of the existing coordinate geometry tools.  The 
main COGO dialog box has been enhanced to include utilities 
for each type of COGO element such as points, lines, curves, 
chains, etc.  The utility dialog box will allow the user to 
functions such as visualize, print, transpose, etc., for each 
element type.  This allows the user to more efficiently work 
with each type of element independently.  The new COGO 
dialog box, along with some of the utility dialog boxes is 
shown below. 

 

 

Figure 17-17: New COGO Tools 

Vertical Design 

There are two tools used to set proposed vertical alignments, 
and both are acceptable to EFLHD.  Engineers and designers 
have used the the VPI based Vertical Alignment Generator 
since the early days of GEOPAK.  This tool, although having 
been around for years is still a user-friendly, accurate method 
for creating and storing vertical alignments.  The second 
method is the Component Based Vertical Alignment 
Generator.  This tool has been updated and improved over 
the VPI based tool, and has yet to be fully utilized by most 17-11
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GEOPAK users.  Both these methods are just as accurate and 
depending on your preference, as easy to use.    There are 
two methods available for creating and storing an Existing 
Ground profile; Traditional method and a the new Draw 
Profile Tool method. 

Existing Ground Profile 
Once a run is created for the working alignment, the existing 
ground profile should be cut and drawn using the D & C 
Manager.  EFLHD’s traditional method for cutting existing 
ground profile is shown below.  Existing Ground Profile can be 
accessed using Project Manager by selecting the Existing 
Ground Profile button. 

 

Figure 17-18:  Accessing Existing Ground Profile 
through Project Manager 

The Existing Ground Profile dialog can also be accessed by 
typing in mdl load ex_prof command in the Microstation 
Key-in box. 

 

Figure 17-19:  Microstation Key-in 

The following Existing Ground Profile dialog box will appear. 

17-12
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Figure 17-20:  Traditional Existing Ground Profile  

Enter in the required information and select Apply.  Apply will 
cut your existing ground profile for the chain and store it into 
the GPK file.  Existing ground profile can be accessed and 
drawn into MicroStation using the Geopak D & C Manager, 
with the EFLHD .ddb file.  This will assure that the existing 
ground profile is placed with the correct symbology. 

Draw Profile Tool - GEOPAK 2004 
New to GEOPAK 2004 is a streamlined way to create existing 
ground profiles, and plot both existing and proposed profiles.  
The Draw Profiles tool is not available through project 
manager, but can be accessed by selecting 
Applications>GEOPAK ROAD>Plans Preparation>Draw 
Profiles, as shown below. 

17-13
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Figure 17-21: Select Draw Profiles 

The Draw Profiles tool may also be accessed from the Plans 
Preparation tool palette as shown below. 

 

Figure 17-22: Draw Profile Icon 

 
All that is needed for this tool is a horizontal alignment and a 
.tin file.  This tool allows for the creation of an existing 
ground profile in much the same way as the Traditional 
method, but does so behind the scenes, with increased 
efficiency and a much cleaner workflow.  This tool also allows 
the user to draw profiles into MicroStation using the D&C 
Manager .ddb settings ensuring adherence to the CADD 
standards.  Also, with the Draw Profiles tool, there is no need 
to delete before re-drawing updated profiles. 

17-14
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Workflow 1:  Creating an existing ground profile using 
Draw Profiles Tool 

1. Select the Draw Profiles tool using one of the 
methods described above. 

  

Figure 17-23: Draw Profile Dialog Box 

 
2. Select the job number where the chain is stored 

and the associated chain. 

3. Select the Dialog Profile Cell Control icon located 
to the right of the job number.  The following 
dialog box will appear. 

 

Figure 17-24: Profile Cell Control 
17-15
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4. Select the Place Profile Cell icon on the top right 

side of this dialog. 

5. Once selected the following dialog box is 
activated allowing the user to set the station and 
elevation for the origin of the profile, set the 
horizontal and vertical scale, and set the top and 
bottom ranges for the cell.  Elevation and Cell 
Range should match the range of Z value for your 
project.   Notice how similar this dialog looks to 
the D&C Manager dialog for placing a profile cell. 

 

 

Figure 17-25: Place Profile Cell 

 
6. Once this dialog box has been populated, the user 

may place the cell where desired.  The Profile Cell 
Control dialog box will now be populated. 

 

Figure 17-26: Profile Cell Control 

 
7. Dismiss the Profile Cell Control dialog box and 

return to the Draw Profile dialog.  Notice that 
before placing the profile cell everything below 
the chain name on this dialog box was grayed 
out. 

8. This dialog box is now active and the user is now 
able to populate the Surfaces and COGO tabs. 

 17-16
3/27/2007  



 

STANDARDS FOR USE WITH X30 CRITERIA

EFLHD CADD Standards Manual 
Chapter 17 — Horizontal and Vertical Design 

 

Figure 17-27: Draw Profile Method 

9. Begin by selecting the correct .tin file. 

10. Once the .tin file is selected the user must 
now decide how to cut the existing ground 
profile.  The options shown above; Triangles, 
Break Lines, POT, Increment, and Even, are the 
same options allowed in the original Ground 
Profile tool.  Select the Triangles option. 

11. Next the user must tell GEOPAK how to 
draw the profile with the correct symbology.  
Previously, the user would use the D&C Manager 
exclusively to accomplish this.  As shown below, 
the Draw Profile tool will use either the D&C 
Manager or allow the user to input symbology. 

 

17-17
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Figure 17-28: Display Settings 

12. Select By feature to access the D&C 
Manager. 

13. Once selected, the paintbrush becomes 
active.  Click on the paintbrush to access the D&C 
Manager.  

17-18
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Figure 17-29: D&C Manager 

14. Select the correct element, shown above as 
CHAINS/PROFILES>CFL/EFL>EXPROF Existing 
ground profile Profile. 

15. Select the OK button in the upper right 
hand corner of the dialog box. 

17-19
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Figure 17-30: Add Surface 

 
16. Once the above dialog box has been 

populated with the correct .tin file, the Method, 
and the symbology, Select the Add Surface 
Settings icon, circled above. 

17. Selecting the Add Surface Settings icon will 
populate the surface into the dialog box and 
instantly draw the profile onto the previously 
drawn profile cell. 

 

17-20
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Figure 17-31: Store Surface in COGO 

 

So far this workflow has allowed us to create the existing 
ground profile and draw it into MicroStation with the correct 
symbology.  In the continuation of this workflow, we will store 
the profile into COGO and plot more information such as 
elevation and station labels, along with anything else that 
was previously available to be plotted from the D&C Manager. 

18. To Store this profile into COGO, select the 
Store Surface in Cogo icon, as shown above. 

17-21
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Figure 17-32: Store Profile 

19. Populate the Profile Name box with the 
desired name.  Check the box labeled Store 
Profile in GPK. 

20. Select Apply. 

21. The profile is now stored in the GPK. 

22. Dismiss the Store Profile dialog box and 
return to the Draw Profile dialog box. 

23. Select the COGO tab and from the Profile 
Name box, select the correct profile. 

 

Figure 17-33: Draw Profile Dialog Box 
17-22
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24. Under the options section, located in the 
bottom quarter of the dialog box, select General. 

 

 

Figure 17-34: Profile Options 

 
25. This allows the user to select the Axis 

labels and the Strip Grade Increment, if desired.  
The additional options are shown below. 

 

 
 

 

Figure 17-35: Profile Options 

 
26. From the options shown above the user has 

the same flexibility in drawing the profile into 
MicroStation as the D&C Manager.  Once the 
desired options have been selected, click the Add 
Cogo Profile Settings icon, as shown below, and 
the profile will be complete.  Multiple profiles can 
be drawn using the COGO tab. 

 

17-23
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Figure 17-36: Profile Drawn Into MicroStation 

The projection tab can be used when the chain and profile 
that needs to be drawn is different than the chain and profile 
used to create the profile cell. 

 

Figure 17-37: Profile Projection Tab 

17-24
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Proposed Vertical Alignment 
The VPI based Vertical Alignment Generator is the traditional 
method used by EFL designers in creating vertical alignments.  
Vertical alignment generator can be accessed through Project 
Manager by selecting the Vertical Alignment button. 

 

Figure 17-38: Accessing Vertical Alignment through 
Project Manager 

The VPI Based Vertical Alignment Design Tool may also be 
accessed from the Horizontal & Vertical Geometry tool palette 
as shown below. 

 

Figure 17-39: VPI Based Vertical Alignment  Icon 

 

Selecting the VPI Based Vertical Alignment Design Tool will 
invoke the dialog box below: 

 

 

 

17-25
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Figure 17-40: VPI Based Vertical Alignment 
Settings 

Once the settings are defined, selecting OK will invoke the 
GEOPAK Profile Generator.   

 

Figure 17-41: Profile Generator 

For EFL projects, the User Preferences are as shown below:   

 

17-26
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Figure 17-42: User Preferences 

If the project requires the use of Maintaining K value instead 
of Maintain VC Length, commonly used, attach the correct K-
Value table.  K Value Table can be accessed by selecting 
User>K-Values. The following dialog will appear: 

 

Figure 17-43: K-Value Table 

Use File>Open to attach the correct unit K-Value table 
(.kvl).  K-Value table can be attached from 
M:\V8_RESOURCE\X_30\Standards\Bin\ english or metric. 

After the proposed vertical alignment is created and saved, 
use the Draw Profile Tool or the D&C Manager to drawn 
profile in MicroStation, ensuring adherence to the CADD 
standards.  For EFLHD projects, the toggles shown below 
must be selected prior to drawing the profile. 

17-27
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Figure 17-44: D & C Manager to Draw Profile 
Draw 

Workflow 2:  Creating Proposed Vertical alignment 
using Component Based Vertical Alignment Design Tool 

The new method to create vertical alignment introduced with     
Geopak 2000 is the Component Based Vertical Alignment 
Design Tool.  This method allows for vertical alignment to be 
created graphically and stored using Store graphics 
command, similar to the horizontal alignment Store Graphics 
command.  The Component Based Vertical Alignment Design 
Tool requires COGO to be active as well as an Active Chain 
and Active Profile Cell.  Component Based Vertical Alignment 
Design Tool requires the use of Active Chain Control, a 
method introduced with Geopak 2000.  Active Chain Control 
can be used in place of the 3 port viewer. 

1. Select the Active Chain Control tool by Selecting 
Application>Geopak Road >Active Chain Control 

17-28
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Figure 17-45: Accessing Active Chain 
Control 

 

Or by selecting Active Chain Control button from the 
Geopak Main dialog box.   

 

 

Figure 17-46: Accessing Active Chain Control through 
Road Tools Icon 

 

Selecting the button will invoke the Active Chain 
Control dialog. 
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Figure 17-47: Active Chain Control Dialog 

 

2. Using the Active Chain Control dialog box, 8 
MicroStation view are available to set the 
graphical data for Plan, Profile and Cross Section.   
In the dialog box shown below, View 1 is the plan 
view, View 2 is the profile view and View 3 is the 
cross section view.  To use the Component Based 
Vertical Alignment Tool, assign your profile to a 
view by right clicking on one of the 8 
MicroStation views and selecting the Profile. 

 

Figure 17-48: Assigning Profile View 

3. Select the Component Based Vertical Alignment 
Tool by Selecting Application>Geopak Road 
>Geometry>Layout Profiles (Component 
Based)

 

Figure 17-49: Accessing Component Based Vertical 
Alignment Tool 

 

Or by selecting Component Based Vertical Alignment 
Tool from the Geopak Main dialog box.  Component 
Based Vertical Alignment Tool is not available 
through the Project Manager.  
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Figure 17-50: Accessing Component Based Vertical 
Alignment Tool through Road Tools Icon 

 

4. Once selected the main Component Based 
Vertical Alignment Tool frame is activated as 
shown below.  The tool frame contains tool boxes 
to place vertical alignment lines, manipulate 
vertical alignment elements, place vertical 
alignment curves and profile tools.  

 

Figure 17-51: Component Based Vertical Alignment 
Tool Frame 

5. From the main Component Based Vertical 
Alignment Tool frame shown above, following 
additional tools can be accessed from each of the 
four main tool boxes.  

 

Figure 17-52: Component Based Vertical Alignment 
Tools 

6. Prior to using the Component Based Vertical 
Alignment Tools to draw, select the Dialog 
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Graphical Profile Preference icon as shown 
below. 

 

Figure 17-53: Dialog Graphical Profile Preferences 

7. Set the Element Symbology for the Line and 
Curve.  Setting the element symbology will allow 
for easier viewing when designing the vertical 
alignment using the Component Based Vertical 
Alignment Tools. 

 

Figure 17-54: Graphical Profile Preferences 

8. Use the Component Based Vertical Alignment 
Tools to graphically draw the vertical alignment. 

 

 

Figure 17-55: Draw Graphical Profile  

9. Once the vertical alignment is drawn using the 
Component Based Vertical Alignment Tools, 
vertical alignment can be stored.  Select Store 
Vertical Alignment icon from the Profile Tools 
dialog to store the vertical alignment. 
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Figure 17-56: Store Vertical Alignment Icon 

10. Once the Store Vertical Alignment icon is 
selected, the following dialog will activate if the 
COGO dialog is not already activated.  Select OK.  
The Component Based Vertical Alignment Tools 
requires COGO to be active. 

 

Figure 17-57: COGO Activation 

11. Selecting Store Vertical Alignment icon will 
activate the following dialog box.  Input the 
profile name and select the elements to store. 

 

Figure 17-58: Store Vertical Alignment 

The various methods for creating horizontal and vertical 
geometry using GEOPAK are describe in this chapter.  
Regardless of the method used, the final alignment and 
profile must be drawn into MicroStation using the GEOPAK 
D&C Manager, with the EFLHD .ddb file.   

Related links:   Using Knucklehead’s Guide for GEOPAK 
Road 2004 Edition. 

To Create the Horizontal Alignment 

Generate the Existing Ground Profile  

To Create the Vertical Alignment  
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http://www.wfl.fha.dot.gov/geopak/idiot2004/cre_va.htm
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